I$^3$S Manta
MANUAL

Interactive Individual Identification System

Manta version 2.1
July, 2008

Jurgen den Hartog & Renate Reijns
i3s@reijns.com
Disclaimer

Interactive Individual Identification System
(Manta version 2.1)

I$^3$S Manta is free software; you can redistribute it and/or modify it under the terms of the GNU General Public License, version 2 or any later version published by the Free Software Foundation.

This manual is released under the terms of the GNU Free Documentation License, version 1.1 or any later version published by the Free Software Foundation.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License and GNU Free Documentation License along with the distribution (COPYING GPL v2.txt and COPYING.DOC.txt) If one of these files is missing, write to the Free Software Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA.
Acknowledgements

I³S Manta has been realized with sponsoring from the Project AWARE Foundation

![Project AWARE Logo](https://www.projectaware.org)

We also would like to thank Guy Stevens from the Maldivian Manta Ray Project for providing the sample database. Amongst others we would like to thank Florencia Cerutti and Aubanie Raynal for testing the software and providing valuable bug reports.
# Contents

1 Introduction to I³S Manta .............................................................................................................. 6
  1.1 What is I³S Manta? ....................................................................................................................... 6
  1.2 The original I³S vs. I³S Manta ........................................................................................................ 6
  1.3 The algorithm ................................................................................................................................. 6
  1.4 Reading this document .................................................................................................................... 8
  1.5 Bug reports, comments and requests .............................................................................................. 8
2 Installation of I³S Manta ................................................................................................................... 9
  2.1 System requirements ...................................................................................................................... 9
  2.2 Software and data requirements ..................................................................................................... 9
  2.3 Installation ...................................................................................................................................... 9
  2.4 Uninstall ....................................................................................................................................... 9
3 Tutorial ........................................................................................................................................... 10
  3.1 Introduction ..................................................................................................................................... 10
  3.2 Tutorial example 1: recognition of a manta ................................................................................... 10
  3.3 Tutorial example 2: construction of a fingerprint ........................................................................... 14
  3.4 Tutorial example 3: using metadata ............................................................................................... 16
4 The I³S user interface ....................................................................................................................... 18
  4.1 The menu bar ................................................................................................................................. 18
  4.2 The tool bar ................................................................................................................................... 23
  4.3 Spot annotation ............................................................................................................................... 23
5 Searching and using metadata ......................................................................................................... 24
  5.1 Adding metadata ............................................................................................................................. 24
  5.2 The search process ......................................................................................................................... 25
  5.3 Actions after the search is completed ............................................................................................. 28
6 Database organization ....................................................................................................................... 30
  6.1 Introduction .................................................................................................................................... 30
  6.2 The directory tree .......................................................................................................................... 30
  6.3 The metadata file ............................................................................................................................ 31
7 Spot annotation ............................................................................................................................... 33
8 Some extra information on I³S ......................................................................................................... 34
8.1 Accuracy ........................................................................................................... 34
8.2 Limitations of $i^3S$ ............................................................................................. 35
9 Future Work .......................................................................................................... 35
10 References ......................................................................................................... 36
1 Introduction to I^3S Manta

1.1 What is I^3S Manta?
I^3S is an acronym of Interactive Individual Identification System. I^3S Manta is an extension of the system using the spot shape and size of the animals and is especially useful for identifying manta rays. This title explains most of I^3S Manta’s functionality. First, we will discuss the interactive part. I^3S Manta requires user interaction and is meant to support but not to replace the researcher. Initially, the user has to point out the most distinguishing features (i.e. the spots and certain reference points) of the unknown individual animal. In the next step, I^3S Manta assists the user in the tedious task of matching animals for identification purposes. It automatically matches an annotated image with all other annotated images in the database and shows a ranked list of images. However, the user will always be responsible for making the final match between the unknown image and an image from the database.

1.2 The original I^3S vs. I^3S Manta
The original version of I^3S was designed for identification of ragged tooth sharks. The recognition procedure is based on the center location of the spots on the shark’s sides, and its dorsal and pelvic fins. I^3S also proved to be useful for other species such as whale sharks. However, I^3S turned out to be less suitable for species with very irregular spots, e.g. manta rays. To accommodate recognition of these types of species I^3S was adapted. The new program was named I^3S Manta. Apart from the spot location, I^3S Manta also incorporates spot shape and size. Where I^3S expected the user to point out the centers of the spots, I^3S Manta requires from the user to draw an ellipse around each spot. Therefore, in I^3S Manta the user interaction has slightly increased. However, because of the extra information about spot shape and size, the precision of the recognition algorithm has increased considerably as well.

I^3S should be used for species with regular spots. In case of considerable spot variation I^3S Manta is advised.

We refer in the remainder of this manual to I^3S Manta as I^3S.

1.3 The algorithm
The identification procedure assumes that the spot pattern of each individual animal is a unique distinguishing feature. The user points out the most distinguishing spots of each image. This spot pattern is stored in what is called a ‘fingerprint file’. You recognize these files by the extension .fgp.

In the identification step, the resulting spot pattern is matched with the spot patterns of all the known animals in the database.

1.3.1 The reference points
To be able to correct for differences in viewing angle and scaling, the user is always required to point out three fixed reference points. The reference points should satisfy the following requirements:
1. Their exact location is consistently and clearly distinguishable.
2. Visible in all images.
3. The triangle made up by the three reference points should cover most spots. Ideally the triangle should have angles of 60 degrees. In most cases this will not be possible, but you should try to get as close as possible for optimal results.
Figure 1-1 shows the reference points advised for manta rays. The base points of the right and left cephalic feeder fins are from the viewpoint of the creature (and not the photographer!). Do not mix-up these reference points as this will inhibit proper recognition.

Each new species will require careful selection of the three reference points as this is critical for performance of I<sup>3S</sup>. If you want to use I<sup>3S</sup> on a new species you are advised to consult the I<sup>3S</sup> team for support at i3s@reijns.com.

1.3.2 Spot comparison

With the reference points selected it is now possible to correct for rotation and scaling and compare two images in roughly the same 2D space or coordinate system. A comparison of two images comes down to finding corresponding spot pairs in the above-mentioned coordinate system. In the current implementation a spot pair is accepted as a good match if the nearest other candidate is at least at twice the distance of the current match. Further, the spot sizes and the ratio between length and width of both ellipses should be sufficiently similar. Figure 1-2 shows the (centers of the) spots of two different images of the same Manta ray in this coordinate system. The red dots denote the spots of the first image while the blue circles represent the spots of the second image. The green lines indicate whether two spots are considered a matching spot pair. From these pairs a distance metric is calculated to be able to rank each image in the database. The current metric is the sum of the distances between each spot pair, divided by the square of the number of spot pairs. Further, differences in shape and size will also affect the final score. The larger the differences in sizes and
width-to-length ratio the higher the score (where a lower score indicates a better match). In general, scores below 4 indicate good candidates.

![Comparison of spots from two images](image)

**Figure 1-2: Comparison of the spots from two images.**

Obviously, there are some limitations to this approach. 2D linear transformations work best for 2D linear animals, which do not exist. However, this approach has proven to be effective if some constraints are considered. For a more detailed discussion on the practical issues you are referred to Chapter 8. For more details on the original algorithm, please see [1]. For specific details on the Manta algorithm, please contact the i3S team by email.

### 1.4 Reading this document

In this document all file and directory names and shell commands are written using the font *Courier New*. All names relating to a part of the i3S user interface, such as **button names** or **menu options**, are boxed.

### 1.5 Bug reports, comments and requests

Please send all bugs, comments and questions to **i3s@reijns.com**. In case of a bug, please describe clearly how we can reproduce the bug ourselves. If possible provide us with all relevant data such as images and fgp-files.


2 Installation of $I^2$S Manta

2.1 System requirements

This version of $I^2$S requires a Windows 32-bits operation system (2000/XP/Vista). The software is developed using Java 1.6 and C++ (MS Visual C++). Both Java and most of the C++ code are platform independent and it should therefore be relatively simple to port it to other platforms such as Linux or Solaris. Other requirements are at least 512 MB of memory (preferably 1024 MB or more), and a 1 GHz CPU or faster. Increase of the database to hundreds of images will increase the minimal requirements on CPU speed.

2.2 Software and data requirements

Because the main program is developed in Java, the Java Run-time Environment (JRE) is required. This distribution will only work with JRE version 6 or higher! The JRE 6 (or higher) can be downloaded for free from the Java website (http://www.java.com/getjava).

$I^2$S supports both JPEG (extension .jpg) or GIF (extension .gif) images. Support of other image types is currently not foreseen as all known digital cameras provide output in JPEG.

2.3 Installation

Run the file I3SM2.1_Setup.exe. If your current Java version is not sufficient you will be notified and installation terminates. It is required to install the Java Runtime Environment 6 or higher first (http://www.java.com/getjava).

Apart from some information about the GNU-license, the installation consists of the following steps:

1. Choosing the home directory where to install the program. Default will be in the directory C:\Program files.
2. Choosing the data directory where to store the image and fingerprint files. The installation will first check whether you already have a data directory by verifying the existence of the I3SM_DATA environment variable. If this variable is found, its value will be used as default.
3. You can indicate if you want $I^2$S to create a folder in the Start menu folder. Finally, you can select some additional tasks:
   a. Creating a desktop item.
   b. Copy examples in your database. If you want to use the tutorial (Chapter 3) please check this item.
   c. Copy the source code. Only if you are interested in using or changing the source code you need to check this item.

Because environment variables have been added you are asked if you want to restart the computer now or later. $I^2$S will not work properly until you restart the computer or logout and login again.

2.4 Uninstall

You can uninstall $I^2$S in two simple steps:

1. Uninstall $I^2$S, using the entry in the start menu folder.
2. Optionally you can also uninstall the Java Runtime Environment (JRE). In general it is not a good idea to uninstall JRE without replacing it for a newer version because other programs may depend on it. However, if you still want to uninstall JRE use the standard procedure: Select Add/Remove Programs (Programs and Features in Windows Vista) in the Control Panel. Then select the appropriate list item and click on the Add/Remove button.
3 Tutorial

3.1 Introduction
During the installation procedure a small sample database can be installed. This database is used during the tutorial. If you do not need the tutorial anymore, the sample database can be removed and replaced with your own data. All sample files and directories start with I3SM_example_.

This tutorial covers three examples. The first example shows the recognition of a manta ray with an already existing fingerprint file. In the second example you will construct the fingerprint file yourself and then compare it with the sample database. In the third example you learn how to work with metadata.

There are also three tutorial videos which can be found on the download page on the website.

3.2 Tutorial example 1: recognition of a manta
In this example you will open a manta ray image together with an already existing fingerprint file. After loading these files you will learn how to compare with the database and interpret the results. Step 1-8 are identification steps. Step 9 places the image in the database after identification, where step 10 only identifies the animal.

1. Start I3S by double clicking on the desktop icon or selecting I3SM2.1 in the start menu folder. The standard I3S window will come up.

2. Select the button. A file chooser window pops up. The starting directory is the top level of the database directory. The database covers all known individual mantas.
3. Go to the installation directory and select the Tutorial directory. Open the manta image in Tutorial1.JPG. The image file is read and displayed in the main window.

This image already has a corresponding fingerprint file, which is apparent from the various spot annotations that are displayed as ellipses.

4. Click the search button to compare this image with the database. I3S pops up a window.

At the left of this window you can indicate which view to use (in this case all views is the only option. In Chapter 4.3 the use of views will be explained). At the right side of the window you can select which part of the database to search. In this example we will keep the default setting. At the bottom part you can put constraints on additional data such as size and tail length. Keep the defaults here as well.

5. Press the search button at the bottom and inspect the results. All fingerprints in the database were matched. The best matches are on the top. Selecting a file while keeping the right mouse button pressed will display more details such as the path to the file and the number of matching spot pairs. Manta 3 looks like the best candidate with Manta 100 as a second best.
6. Repeat step 4 and 5. Now we assume that the unknown manta is female. Therefore, we select in the search window Female and Unknown sex database. Now, only the female mantas and mantas of unknown sex are used in the search.

Note that various mantas have disappeared. If you know the sex of an unknown manta, you can speed up your search while the results will be more accurate.

7. Select the top file and then click on the button [Visual comparison]. A window with 4 tab panes pops up. The first tab shows both images together. With the second and the third tab it is possible to switch between both images.

8. Select the fourth tab: [Spot cloud]. This tab shows a diagram that represents the model used by I3S to calculate the quality of the match between both images. Red dots represent the spot centers of the unknown manta. The blue circles represent the manta from the database. Green lines indicate the matching pairs. Inspect the spot patterns and the spot pairs. The more direction and length of the green lines are correlated locally, the higher the probability of a good match. Repeat steps 5, 6 and 7 for other search results.
9. Manta 3 is indeed the correct match. Because the tutorial image is of good quality we want to add it to the database to be used in future search actions. Press the [Include in database] button. A new dialog window pops up. It makes sense to check [Rename file] and change the name to something with Manta3.

   ![Include in database dialog]

If you press OK Tutorial1.jpg will be copied under the new name to the Manta3 folder in the (female) database and all open windows are closed.

10. Repeat step 1 to 8 but use the image OnlyIdentification.jpg from the tutorial directory. This image is identical to Tutorial1.jpg. Now press the [Only identification] button. The window that pops up next allows you to rename the image file. Change the filename in the text field.

   ![Identify dialog]

You want to use this step if it is not necessary to add a new image to the database but you want to rename the file name of the previously unknown individual.

11. Press the OK button. All open windows are closed. With the standard Windows Explorer you can verify that both the image and the fingerprint file in the Tutorial directory have been renamed.

   ![Verifying renaming]

End of tutorial example 1
3.3 Tutorial example 2: construction of a fingerprint

In Tutorial example 1 the fingerprint file already existed. In this example you will learn how to create a fingerprint.

1. Start i3S. Open the image tutorial2.jpg from the Tutorial directory. Notice in the file chooser window the different icons used for images with a corresponding fingerprint file and shark images without.

   With fingerprint file:  
   Without fingerprint file:  

2. To be able to start selecting dots i3S needs to be put in edit mode.

   Press  

   After pressing the button will turn yellow to indicate that the edit mode is on.

   i3S now asks you to point out the start of the first reference point. In case of a manta that will be ‘Base right cephalic’.

3. Click with your left mouse button on the start of the mantas right cephalic fin. A circled red dot and the text ‘Base right cephalic’ mark this point. i3S will immediately ask for the start of the second reference point.

   Notice that the red exclamation mark has a yellow background. This symbol tells you have started editing the fingerprint file and you did not save your results yet.

   Select with your mouse button the other reference points. Now you can start annotating spots.
4. Position the cursor on the edge of a spot, press the left mouse button and keep it pressed. Now slowly drag the cursor to the other side of the spot. A circle has appeared with 4 control points and a center. Adjust the ellipse by pressing CTRL and the left mouse button while on one of these control points. Drag the mouse again (while keeping both pressed) and you'll see the ellipse change shape.

Continue with the annotation. Select the most distinguishing spots first. Try not to annotate spots far outside the triangle set up by the reference points (see Chapter 7 for more details). A counter in the tool bar shows the number of annotated spots.

When you click the middle or right mouse button you will remove the nearest dot. If this is one of the reference points you will immediately be asked to point it out again. With CTRL-Z and CTRL-R you can undo and redo actions.

5. Select . If you have annotated the reference points and your spots correctly you should be able to get a top 3 consisting of Manta 3 images.

If you get inconclusive results compare your annotation with the image Tututorial1.JPG

6. Select File → Save fingerprint or press CTRL+S or use the button. Your results are saved into a file with extension .fgp. Notice that the exclamation mark has turned to its normal color.
3.4 Tutorial example 3: using metadata

In addition to the spots and the reference points, I^3S allows the user to add extra information to an image. So, during search you can also refine your search by putting constraints on the metadata.

1. Open the image Tutorial1.JPG

2. Click on the button in the toolbar. A window will pop up. In the text panel you can add any comments. This information is for personal use only, it will not affect the search process.

The Metadata elements panel shows various annotation options. In this example there is a numerical field (Size), a relative field which allows for Small, Medium and Large (Tail length) and a so-called Boolean field which only allows for Yes/No (Scarred).

Try to adjust some of the settings.
3. Click the OK button to accept the changes. Note: these changes are not final until you save. Now press to open the search window again.

4. Adjust the settings of the metadata elements according to the image shown and press Search.
5. Compare the results with the search results from the first tutorial. You will see that the number of results is smaller due to the constraints imposed on the search query. Searching on metadata allows you to further limit the database making searching faster and more accurate. However, keep in mind that animals change over time and that the information in your metadata may not reflect the actual situation.

![I3S Manta: Search results](image)

End of tutorial example 3

4 The I3S user interface

This chapter will address the possibilities of the I3S user interface. First, the menu bar and toolbar are described. Next, the interaction with the annotation panel is discussed.

4.1 The menu bar

I3S offers a standard Windows look & feel menu-based interface to perform all operations. In the paragraphs below, the current five menu items will be briefly discussed. An overview of the menu bar is shown in Figure 4-1.

![I3S: Intelligent Individual Identification System (Manta v2.1)](image)

**Figure 4-1: The I3S menu bar.**

4.1.1 The File menu

This is the main I3S menu. Figure 4-2 shows the various operations which are discussed below:

- **Open image** (shortcut **CTRL+O**). It will open a window to choose an image file. The supported image types are JPEG and GIF. The starting directory will be the value in the environment variable `I3SM_DATA`. If an image file has a corresponding fingerprint file (i.e. the same name but
extension .fgp) a manta logo is shown, a standard image logo otherwise. The logos are shown below:

- (with .fgp)
- (without .fgp)

- **Save fingerprint** (shortcut \texttt{CTRL+S}). If you have been editing the spots in an image this operation will write a fingerprint file in the same directory as the corresponding image. Apart from the extension, which is .fgp, the name will be identical to the name of the image file.

- **Close image**. It closes the image in the main window. If you have unsaved data IS will prompt you whether you want to save the data first.

- **Print image** (shortcut \texttt{CTRL+P}). It will print the current image including comments (see paragraph 4.2).

- **Exit** (shortcut \texttt{CTRL+X}). This operation will close all windows. In case of unsaved data IS will prompt you whether you want to save the data first.

4.1.2 The Edit Menu

This menu allows to manipulate annotations. Make sure you select an ellipse first by clicking on it while pressing Ctrl.

- **Copy** will copy the currently selected ellipse (Shortcut: \texttt{CTRL+C}).

- **Paste** will paste the copied ellipse into the image, just next to the selected ellipse. (Shortcut \texttt{CTRL+P}).

- **Delete** removes the currently selected ellipse (Shortcut: \texttt{CTRL+Delete}).

- **Undo** and **Redo** are completely analogous to standard Windows functionality. The last 500 edit actions are kept in memory (Shortcuts: \texttt{CTRL+Z} and \texttt{CTRL+R}).

- **Selection [direction]** moves the selected ellipse in the chosen direction.

![Figure 4-2: The file menu.](image)
4.1.3 The Database menu

- **Search in database** will compare the current image with the rest of the database. See Chapter 4.3 for details.

- **Insert in database** In case of a loaded and annotated image, selecting this operation will allow you to add a new animal (i.e. a new subdirectory) to the database. This operation pops up a new window first that will prompt you for the database section (male, female, unknown sex), relevant view (if appropriate), and name of the new animal. Selection of the checkbox **Rename file** will allow you to change the name of the image (note: not the name of the animal which is determined by the subdirectory name). Since the results of a search operation only shows the names of the best matching images, it makes sense to make sure all filenames clearly indicate the name of the individual animal. By pressing **OK** the image and its fingerprint file are copied (not moved) to the new directory in the database.

- **Update database** If the database has been changed, i.e. fingerprint files have been manually added or removed using Windows explored, this operation will reload the entire database. You do not have to call this operation after insertion of a new animal in the database. In this case, i3S will update the database automatically.
Figure 4-5: Insertion in the database.

4.1.4 The Tools menu

Options will pop-up the window shown in Figure 4-6. The first section Species allows to select the Species under study. Selection of a species only affects the naming of the control points. The selection is dynamically generated from the file metadata.xml which can be found at the top level of the database directory (pointed to by the I3SM_DATA variable). If you want to assign names to the control points of a new species, you need to manually edit this file. The format is discussed in paragraph 6.3. In case problems do occur, please consult the I3S team at i3s@reijns.com.

The second part Logging results of the options window concerns the automated logging of the searches performed. If logging is on, the outcome of each search will be written to a file in the installation directory. The naming of the file is SearchResults__<date>_<<time>>.log. For example, a search on the July 2, at 17:22:10 will be written to the file named SearchResults__20070702_172210.log. The content of the log file is identical to the results in the search results window. Each line contains a filename, number of spot pairs and the score separated by tabs. This format can be processed by Excel.

The third part Show results can be used to indicate whether you are interested in the top 50 of best matches or the entire database. This choice will affect both the logging and the search results window.
The part named **Color settings** allows you to select which colors to use for the annotation elements. This can be particularly helpful if the species under study happens to show colors similar to the default colors used or if you are color-blind.

### 4.1.5 The Help menu

- **Open manual** will start Adobe Acrobat and open this document.
- **About I*S...** shows a window with information on version number, authors, copyright and contact details.
4.2 The tool bar

Below the menu bar I3S shows a tool bar which offers short cuts to functions described in the previous paragraphs and some new functions. An overview of the tool bar is shown in Figure 4-8.

The table below discusses the various items.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Open file" /></td>
<td>Open file. Shortcut for the menu option described in paragraph 4.1.1.</td>
</tr>
<tr>
<td><img src="image" alt="Save file" /></td>
<td>Save file. Shortcut for the menu option described in paragraph 4.1.1.</td>
</tr>
<tr>
<td><img src="image" alt="Print file" /></td>
<td>Print file. Shortcut for the menu option described in paragraph 4.1.1.</td>
</tr>
<tr>
<td><img src="image" alt="Search" /></td>
<td>Search. Shortcut for database search described in Chapter 4.3. A keyboard shortcut is ALT+S.</td>
</tr>
<tr>
<td><img src="image" alt="Edit information field" /></td>
<td>Edit the information field. Each fingerprint file contains an information field. Upon pressing the button, a metadata editor is opened (see paragraph 5.1 for details).</td>
</tr>
<tr>
<td><img src="image" alt="Edit mode" /></td>
<td>This will toggle I3S edit mode whether or not an image is currently loaded. You can only change the annotation if the edit mode is ‘on’. The keyboard shortcut is ALT+P. If edit mode is on, the button becomes yellow.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom in" /></td>
<td>Pressing the plus will zoom in on the image. If the enlarged image does not fit the screen two sliders will appear. The mouse wheel can also be used for zooming.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom out" /></td>
<td>Idem for zoom-out. Zooming out allows for selecting control points outside of the image. The advantage of this feature is discussed further in Chapter 7.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom factor" /></td>
<td>The zoom-factor. The maximum allowed zoom factor is 1000%.</td>
</tr>
<tr>
<td><img src="image" alt="Number of spots" /></td>
<td>The number of annotated spots in the image.</td>
</tr>
<tr>
<td><img src="image" alt="Change indicator" /></td>
<td>Change indicator. If the annotation has changed the button becomes yellow until the fingerprint is saved.</td>
</tr>
</tbody>
</table>

The text field to the right of the exclamation mark is used for showing a remark to annotate a reference point first (only if edit mode is on, and one or more reference points are missing). For example, if in a manta images the first reference point is missing this area will look like this:

```
Point out Base right cephalic
```

4.3 Spot annotation

An important part of the user interface is focused on spot annotation. Below the annotation process is discussed in the two steps during annotation: reference points annotation and spot annotation. The annotation process starts with loading an image and putting I3S in edit mode, both were described earlier in this manual.

4.3.1 The reference points

For the algorithm it is essential to have a first indication how two images roughly match. For this step the reference points are used. If the reference points are not annotated, I3S requires you to annotate
these first. The name of the reference point to be annotated is shown in red (yellow background) in the toolbar.

Just click at the appropriate position in the image. I³S will ask you to annotate the other reference points if necessary. In case of an error just click the middle button near the erroneous reference point. The reference point (or spot) closest to the mouse will be removed.

4.3.2 The spots
After annotation of the reference points you can start with the spots. Click on the image and drag the mouse while keeping the left button pressed along the image. A circle appears along the path you drag. Each circle has 4 control points and a center point. You can manipulate the ellipse by dragging one of the control points or its center. Keep the control button pressed and click on one of these control points while keeping the left mouse button pressed. If you drag the mouse, the selected control point will come along whilst changing the shape or place of the ellipse.

Figure 4-9: Annotation in two steps. First dragging a circle (left). Secondly, adjusting the ellipse to fit the spot (right).

4.3.3 Various edit tools
You can always undo an edit action (or multiple edit actions) by pressing \texttt{CTRL-Z}. You can redo one or more edit actions by pressing \texttt{CTRL-R}. Select an ellipse by clicking on its center while pressing \texttt{CTRL}. Using \texttt{CTRL-C} and \texttt{CTRL-V} you now copy the selected ellipse and paste a copy of it. By pressing \texttt{CTRL} and one of the arrow keys you can move the selected ellipse a small step in the corresponding direction.

5 Searching and using metadata
This chapter discusses the search process in more detail. First, the options to add metadata are discussed. Next, the search process is described in detail.

5.1 Adding metadata
I³S allows you to add metadata to an image. Metadata is additional information which describes the individual or perhaps the conditions in which the image was taken. If you press the \texttt{i} button in the toolbar a new window pops up. The window is shown in Figure 5-1.
The upper text field allows you to store plain text. There is no limitation to its length. If no text has been added yet, the string ‘Empty comment field’ is shown.

The Metadata elements field below allows for a more structured input. Three types of fields are available: numeric, general size with three possible values (small, medium, large) and Boolean (yes/no). The standard example above shows an example of each type. The numeric field expects a number using the keyboard. The other types are set by selecting a value from the dropdown menu. I3S allows you to include metadata elements in the search process described below.

![Figure 5-1: The metadata window.](image)

The order or selection of metadata fields is not fixed. It is defined in the file metadata.xml. For more information you are referred to paragraph 6.3.

### 5.2 The search process

After selection of search from the menu or pressing the search button, a new window will appear as shown in Figure 5-2 (left). By pressing the search button directly, you will initiate a standard search where the current image is compared against the entire database.

However, the window offers several possibilities to refine your search. If the sex of the animal in the current image is known, you can improve accuracy and speed-up the search by only searching in the appropriate parts of the database (i.e. Male & unknown sex, Female & unknown sex).

If multiple views are used (e.g. left and right views or top and bottom views, see also paragraph 6.2) you can select these views. If no views are available, you can only select All views. For more information on using views and the database organization you are referred to Chapter 6.
You can also search on specific metadata. The metadata is defined per species in the file metadata.xml in the top of the data directory (paragraph 6.3). You can select per type of field the appropriate constraints (e.g. equals, is less than, is greater than). If you select the default don’t care, that field will not affect the search process. If one or more metadata elements do not satisfy the search constraints, the specific image is excluded from the search results. If a metadata element is not available (i.e. not yet annotated) the search process will ignore this specific element and not exclude the image.

When you click Search the Search result window appears. If the search takes more than a second a progress bar is shown. By clicking one of the results in the list the button Visual comparison becomes clickable. When clicking it a new window will appear as shown in Figure 5-3. The window contains four tab panes. The first shows both images together with the annotated spots and comments. The second and third tab pane show the image of the unknown animal and the selected animal from the results list respectively. The fourth tab pane displays the optimal match between both spot clouds (Figure 5-4). Reference points are shown as double circle or double squares. Matching spots are indicated by the green line between them. This green line may not be visible in case the spots are really close.
Figure 5-3: Visual comparison tab.

Figure 5-4: Comparing the spot clouds.
5.3 Actions after the search is completed

Based on the information in the ‘Compare results’ window you will ultimately decide whether the individual is already known or unknown. You have four options how to proceed:

1. The individual is known and because the image is of good quality you want to add it to the database as reference in future searches.
2. The individual is new and you want to add it to the database.
3. The individual is recognized but you do not want to add it to the database. You only want to rename the image.
4. You do not want to undertake any action.

These four options are supported in the same order by the buttons at the bottom of the window. Figure 5-5 shows these buttons in more detail.

5.3.1 Include in database

Only add good quality images to the database. Poor quality images (e.g. large camera angle with respect to the animal) will lead to poor quality search results. Ideally, aim at having about three reference images per individual. When clicking on the ‘Include in database’ button the following window will appear.

![Image of the 'Include in database' window]

By clicking the field [Rename file] you can also edit the filename. The fingerprint file will get the same name, only with extension .fgp. We strongly advise to make sure that each filename contains the identification number or name of the individual. After clicking [OK] both the image and the fingerprint file are copied (not moved) to the same directory as the matching image you selected.

5.3.2 New individual

If no matching individual was found you will probably assume it is not yet in the database. To add it to the database, click on the appropriate button. The following window will appear.
Figure 5-7: The 'New individual in database' window.

As there is nothing known about sex or view, you need to provide all necessary information. Select the sex first. If your database contains views these will also appear as clickable options. Manta rays have only one view so in this case the view option is not shown. Next, fill in the name of the individual. This can be a name like ‘Gregory’ or just a number such as ‘Manta 301’. This name will be the name of the new directory. In the next section you can choose to rename the image and fingerprint file. We strongly advise to rename the file so it represents the identity. So, in case of Gregory you could name the file Gregory-12March2009Yap.jpg if the photo was taken at Yap on March the 12th. After clicking OK both the image and the fingerprint file are copied (not moved) to the new directory you just specified.

5.3.3 Only identification

If you have successfully identified an individual but do not want to include the image in the database, you still might want to rename the file. In this case, press Only identification and the following window will appear.

Figure 5-8: The 'Only identification window'.

Fill in the new name and make sure it ends with .jpg and press OK next. Both image and fingerprint file will be renamed.
6 Database organization

6.1 Introduction

I3S compares unknown images with a database consisting of a collection of image-fingerprint pairs. In this document, with database the collection of known images used for reference by I3S is meant. Possibly you will have another database or collection of unknown images, but that is considered as an entirely different database.

Each image is accompanied by a fingerprint file containing all information added in the annotation process. Always treat these images as an inseparable pair. If you move one of the files to another directory you should always move the other file along.

All data is structured by means of a directory tree which is described in paragraph 6.2. Each image is described by the annotated spots and by means of metadata fields (see also paragraph 5.1). The structure of the metadata is described in paragraph 6.3.

6.2 The directory tree

The entire database consists of a so-called directory tree. We distinguish the top-level directory, which contains only the directories Male, Female and UnknownSex and the file metadata.xml. The directories may only contain individuals of corresponding sex. Each subdirectory in one of the three possible directories (Male, Female, UnknownSex) represents a single individual animal. Within each individual directory you can have multiple views. Each view is represented by a specific directory. Make sure that the naming of these directories is consistent throughout the entire database. If you only use a single view, you do not have to use specific view directories. In this case you can just add your image and fingerprint files in the directory with the name of the corresponding individual.

For example:

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\I3S\Data</td>
<td>Top level directory. It contains directories Male, Female and UnknownSex.</td>
</tr>
<tr>
<td>C:\I3S\Data\Male</td>
<td>This directory contains directories for individuals such as Ronald, George and Bill.</td>
</tr>
<tr>
<td>C:\I3S\Data\Male\Jimmy</td>
<td>This individual directory contains the view directories Left and Right for the individual Jimmy.</td>
</tr>
<tr>
<td>C:\I3S\Data\Male\Jimmy\Left</td>
<td>This view directory contains image and fingerprint files JimmyLeft001.jpg, JimmyLeft001.fgp, JimmyLeft002.jpg, JimmyLeft002.fgp.</td>
</tr>
<tr>
<td>C:\I3S\Data\Male\Jimmy\Right</td>
<td>This view directory contains image and fingerprint files JimmyRight001.jpg and JimmyRight001.fgp.</td>
</tr>
</tbody>
</table>

At the lowest database level, the subdirectories should only contain image files and fingerprint files (extension .fgp). Other file types are ignored. The image files should be of type JPEG (extension .jpg or .jpeg) or GIF (extension .gif). Each fingerprint file corresponds with the identically named image file (apart from the extension). A fingerprint file contains all the spot and extra information of the corresponding image file. The sample database provided with the distribution contains several individual mantas (i.e. subdirectories).
At start-up, I^3S looks up the environment variable I3SM_DATA and starts to parse all the fingerprint files in the corresponding directory and subdirectories. All fingerprint files are stored in memory for quick future reference during execution of search tasks. Since the fingerprint files are quite small (usually about 1 KB) the memory use of the database will be limited.

### 6.3 The metadata file

The file metadata.xml defines all known species. For any species the following information must be specified:

1. The names of the three reference points.
2. The existing metadata fields. For each metadata field a name and type has to be specified.

The file metadata.xml can be found in the top level directory of the database. If you want to add another species or add new metadata fields you will have to edit this file. The contents of the file are plain text and are shown below. For clarity, comments are shown here in blue.

```xml
<?xml version='1.0' encoding='utf-8'?>
<structure>
  <species type="Manta ray">
    <c1>Base right cephalic</c1> <!-- Name of 1st reference point -->
    <c2>Base left cephalic</c2>  <!-- Name of 2nd reference point -->
    <c3>Base tail</c3>            <!-- Name of 3rd reference point -->

    <!-- Description of metadata which can be added to this species -->
    <!-- Name can be anything. Type can be number (e.g. 5.3),
    smallmediumlarge (either small, medium or large) and yesno -->
    <!-- (either yes or no). -->
    <metadata>
      <name>Size</name> <type>number</type>
    </metadata>
    <metadata>
      <name>Tail length</name> <type>smallmediumlarge</type>
    </metadata>
    <metadata>
      <name>Scarred</name> <type>yesno</type>
    </metadata>
  </species>
  <species type="Generic">
    <c1>Ref1</c1>
    <c2>Ref2</c2>
    <c3>Ref3</c3>
  </species>
</structure>
```

The structure is in the so-called XML-format. The format should be more or less self-explaining. If after editing I^3S reports an error, consult the I^3S team for advice.

I^3S currently supports only three types of metadata: number, smallmediumlarge and yesno. The number format will accept any number such as 0, 12, 4.2 and -5. The type smallmediumlarge is a variable with three possible values (small, medium and large). Analogous, the yesno type is a Boolean variable with values yes or no. If you have need for other types of variables, please contact the I^3S team. The number of metadata fields is limited to 20.
If you would like to add a new species called ‘Deep sea monster’, with the reference points ‘left deadly fang’, ‘right deadly fang’, ‘poisonous tail’, and the metadata fields ‘fang size’ and ‘number of tentacles’ the new metadata file may look like this:

```xml
<?xml version='1.0' encoding='utf-8'?>
<structure>
  <species type="Manta ray">
    <c1>Base right cephalic</c1>
    <c2>Base left cephalic</c2>
    <c3>Base tail</c3>
    <!-- Description of metadata which can be added to this species -->
    <!-- Name can be anything. Type can be number, smallmediumlarge -->
    <!-- (either small, medium or large) and yesno (either yes or no) -->
    <metadata>
      <name>Size</name> <type>number</type>
    </metadata>
    <metadata>
      <name>Tail length</name> <type>smallmediumlarge</type>
    </metadata>
    <metadata>
      <name>Scarred</name> <type>yesno</type>
    </metadata>
  </species>
  <species type="Deep sea monster">
    <c1>Left deadly fang</c1>
    <c2>Right deadly fang</c2>
    <c3>Poisonous tail</c3>
    <metadata>
      <name>Fang size</name> <type>smallmediumlarge</type>
    </metadata>
    <metadata>
      <name>Number of tentacles</name> <type>number</type>
    </metadata>
  </species>
  <species type="Generic">
    <c1>Ref1</c1>
    <c2>Ref2</c2>
    <c3>Ref3</c3>
  </species>
</structure>
```
7 Spot annotation

This chapter will discuss the proper procedure to point out the spots on the animals. There are some rules which will be discussed below:

1. Only use images where you can see the reference points. To be able to compare images with each other the proper positioning of the three reference points is essential. Sometimes, a reference point may be just outside the image. However, based on other features you may be able to guess where it should be. An example is shown below where the base of the tail is just outside the image. In such a case, you can use the zoom feature to zoom out. I\$S allows for annotation of reference points outside of the actual image.

![Figure 7-1: Annotation of the base of the tail just outside the image.](image)

2. Only select spots more or less between these three reference points. Spots outside this area will in general be harder to match with other images. For example for manta rays, spots in the area around the wing tips are not good candidates as this area is most likely to bend during swimming. From a matching point of view, this results in serious non-linear deformations. These spots have proven to be an important cause of mismatches. As a general rule do not select spots in areas susceptible to deformation or (far) outside the area bounded by the reference points.

3. Select approximately 10 - 20 spots in each image but only if available within or just outside the area described previously. The system requires a minimum of 2 spots.
4. Try to take your photographs as perpendicular to the animal as possible. I^3S’s performance will seriously degrade when the viewing angle exceeds 40 degrees ([2]). However, small angles may have a negative impact as well.

5. When selecting spots, start with the most distinguishing (biggest) spots first. This strategy works better than working methodically from left to right or a similar strategy. Only select spots that are likely to be visible in other photos as well.

6. Only add good quality images to the reference database. If you have positively identified an image you can choose to copy the image and its fingerprint file to the database. However, if the image itself is unclear, poorly lighted, or taken from a large distance or an odd angle this will have impact on the quality of the selected spots. Computer applications in general, including I^3S, work according to the Garbage In – Garbage Out principle. If you put poor quality images into the database this will most likely deteriorate the overall performance. If possible, use only the best quality images as reference material, as this will significantly increase the possibility to be able to identify your poor quality material.

7. Keep a balanced database. Usually, you will not have the same number of (good quality) images for each animal. However, do not put extra images of a specific animal in the database just because you have the data. The larger the number of reference images, the greater the chance of a mismatch. On the other hand, too few images per individual might result in poor performance as well. From experiments, the optimal number of reference images seems to be 3 to 5 images per individual (see also paragraph 8.1).

8. Label consistently. Sometimes it is difficult to determine whether a peculiarly shaped spot should be labeled with one or two ellipses. The same applies to whether you should label scars. There is no ‘golden rule’ how to annotate the spots. However, the most important rule is that you should be consistent in your labeling. If multiple persons are adding new animals to the database it makes sense to use some kind of labeling protocol.

8 Some extra information on I^3S

8.1 Accuracy

The I^3S software was tested with a ragged tooth shark database of 739 images (219 individuals) taken on the Aliwal Shoal over 9 years. The performance of the software was rigorously tested by randomly selecting one, two or three reference images per shark from the dataset and using all the remaining shark images as a test set. We measured the number of times the correct shark was ranked in the top 1, 3, 5 and 10 best matches as a percentage. To correct for random effects, the experiment was repeated 100 times and the average calculated over all results. See [1] for more details. Below are the results of this experiment.

<table>
<thead>
<tr>
<th>Number of reference images</th>
<th>Percentage of images correctly ranked:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Top 1</td>
</tr>
<tr>
<td>1 reference image per shark</td>
<td>71.8</td>
</tr>
<tr>
<td>2 reference images per shark</td>
<td>87.4</td>
</tr>
<tr>
<td>3 reference images per shark</td>
<td>91.7</td>
</tr>
</tbody>
</table>

Table 8-1: Accuracy of I^3S.
From the table above it is obvious that you should try to construct a database with at least 3 images per animal.

In the case of manta rays there are several effects expected on the accuracy of $I^3S$. First, compared to e.g. whale sharks, mantas are very agile which makes it harder to photograph from perpendicular angles while the location of spots will vary more because of bending of the body. On the positive side, mantas have a much larger variation in the size of their spots (i.e. spots are more distinguishing) which will make $I^3S$ more accurate. However, because an annotated database of manta rays of sufficient size is not yet available, it has not been possible to carry out a similar experiment. Small database experiments indicate that performance is a bit lower than on the ragged tooth sharks.

### 8.2 Limitations of $I^3S$

Although the use of $I^3S$ has been shown on a large group of animals, there are some limitations you should consider. Below we will discuss the most important issues.

#### 8.2.1 2D vs. 3D

The main limitation is that a 2D model is used for a 3D animal. Especially with increasing observation angles the limitations of the 2D approach become apparent. Speed et al. [2] carried out experiments and from this research it appeared that accuracy deteriorates considerably with angles larger than 40 degrees. For the moment we therefore advise to use photos taken from a viewing angle smaller than 30 degrees whenever possible. This is particularly important for the photos (to be) included in the database.

#### 8.2.2 Linearity

Even in case of a 3D model, we still assume linearity of the animals. In plain English: we assume that the sharks are rigid and their body parts are always in the same position with respect to each other, which is an optimal situation for comparison. Luckily, there are many slow moving animals such as ragged tooth sharks and whale sharks that have their body parts in more or less the same position. The only part where this assumption usually is not true is the tail, which bends to left and right during swimming. Therefore, if you do not select spots in the tail area you will avoid most problems with non-linearity.

Manta rays are often photographed while bending their body. The central part will be affected less than the wing tips. Spot selection therefore has to be limited to the central part. Nevertheless, compared to e.g. whale sharks some negative impact of the way mantas move is only to be expected. For other animals than manta rays you should select an area which is least likely to be affected by bending of the animal’s body.

### 9 Future Work

In the near future $I^3S$ will be extended with new functionality. We are always open to you suggestions. For the moment we foresee the following:

- Management of multiple species within one database.
- Integration of $I^3S$ Classic and $I^3S$ Manta in one application.
- Use of multiple cores to speed-up searches.
- Incorporate text searches.
- Automatic alerts of available software updates.
10 References
